MAC Tips and Tricks

Prepared by: Ivan Sestak

September 28, 2011

Faculty of Information, University of Toronto
Contents
What is the purpose of the Dock? ................................................................. - 3 -
System Preferences .................................................................................... - 4 -
Customizing the Dock ................................................................................ - 4 -
New Menu Bar .............................................................................................. - 5 -
The Apple Menu ........................................................................................... - 5 -
The Finder Menu ........................................................................................... - 6 -
The Go Menu .................................................................................................. - 7 -
File, Edit, View, and Window Menus .......................................................... - 8 -
Spotlight ........................................................................................................ - 10 -
Navigating OS X ............................................................................................ - 12 -
Shortcuts on the Desktop ............................................................................. - 14 -
How to Copy and Paste with a Mac ............................................................... - 15 -
Installing Applications .................................................................................. - 16 -
  Acquisition .................................................................................................. - 16 -
  Un-package ................................................................................................ - 16 -
  Installation .................................................................................................. - 17 -
Burning CDs ................................................................................................... - 19 -
Burning ISO’s ............................................................................................... - 20 -
Taking Screenshots ...................................................................................... - 22 -
GIVE YOURSELF SOME SPACE ............................................................... - 23 -
EXPOSÉ YOURSELF .................................................................................... - 25 -
Visit the Hot Corner ..................................................................................... - 28 -
Application Switcher .................................................................................... - 29 -
Working with Windows .................................................................................. - 29 -
Frequently Asked Questions ......................................................................... - 30 -
What happened to my Windows Menu?
Where is the trash?
Where are my control panels?

All of these questions are answered by the new OS X feature known as the **Dock**. When you turn on your computer running OS X, the Dock is placed at the bottom of your screen by default. Windows users will find the Dock very similar to the taskbar.

**What is the purpose of the Dock?**
The Dock serves many purposes:

- It can be customized to hold shortcuts to the applications and folders you use most, much like your old Apple Menu.
- It holds the Trash can, System Preferences, and a shortcut to the Finder application.
- It shows all currently opened applications and minimized windows as icons.

To add a shortcut to the Dock:

1. Click and hold an application or folder icon.
2. Drag and drop the icon on the dock. It will automatically open a space for you. Application shortcuts are stored on one half of the Dock (with the Finder), and folder shortcuts are stored on the other half (with the Trash).

**NOTE:** Dock icons are also commonly referred to as "Docklings".

**Trash**

In OS X, Trash functions just as it did in OS 9. To delete a file, remove a Dockling, eject a disk, or disconnect from a network drive, simply drag the item to the Trash.

**Finder**

Rather than having to double-click your hard drive icon, you can now click the Finder icon, which shows up as the first icon in the Dock.
System Preferences

Most of the functions you will need to customize or setup your system are found in the System Preferences application, which has a shortcut in the Dock by default.

Customizing the Dock

To customize the Dock:

1. Open System Preferences by clicking on its icon in the Dock.
2. In the section labelled "Personal," click on the Dock icon.
3. Now you can customize the Dock's appearance and behavior to your liking.
4. When you are done, quit the System Preferences and your settings will be applied.

1. Why is there a little black arrow next to some of my Docklings?

This arrow is telling you that these applications are open. Clicking the icon will bring its application to the forefront. To quit the application (and remove the black arrow), hit Command-Q on the keyboard or select Quit from the application's main menu at the top of the screen. You can also Control-click the icon and select Quit.

2. Why does the Dock have two sides? Why is there a line through the Dock? Can I remove the line?

The Dock is divided into two sections. One section holds application icons, the other holds minimized windows, folders, and Trash. These sides are separated by a thin bar. This bar cannot be removed.

3. I'm trying to put a folder or application in the Dock, but it won't allow me to. What's wrong?

Make sure you are dropping it on the appropriate section of the Dock. If you are creating a shortcut to a folder, you will not be able to place it on the side where application icons are stored. If you are trying to make a shortcut to an application, make sure you are not attempting to put it on the same side as the Trash can.

4. Why is one of my Docklings bouncing up and down?

This can mean one of two things: 1) The application is starting up. 2) The application wants your attention. Click on the bouncing icon to find out why.
Finder is the application used to navigate and control everything in OS X. Clicking on the Desktop takes you back to the Finder interface.

New Menu Bar

The default menu bar in OS X (as shown above) has similarities and differences to the menu bar in OS 9. For instance:

- **File, Edit, View, Window, and Help** menus were all present in OS 9
- There are new **Finder** and **Go** menus
- The **Apple Menu** has changed dramatically
- There is no longer a **Special** menu

Navigating Your Computer

The Apple Menu

The first thing you will notice is that the Apple Menu no longer holds shortcuts to folders and applications you commonly use. This feature has been taken over by the Dock, as discussed in the Dock section of this tutorial.

**Apple Menu Items...**

Below is a list of every standard Apple Menu Item and its function.

- **About This Mac**: Brings up a window containing information about what version of OS X you are using, how much RAM (memory) your computer has, and processor specifications.

- **Get Mac OS X Software...**: Takes you to the Downloads section of Apple's website.

- **System Preferences**: Opens the System Preferences application. Same function as clicking on the System Preferences icon in the Dock.
Dock: Moving your mouse pointer over Dock will bring up a menu with a few Dock preference items, as well as a link to the Dock System Preferences.

Location: Allows the user to select from a list of locations,

Recent Items: Shows a list of all recently opened files and applications for quick access.

Force Quit: Opens the Force Quit window, displaying all open applications. If an application freezes, you can open this window and select to Force Quit any single application without affecting the others. Typing Command+Option+Esc. on the keyboard also brings up the Force Quit window.

Sleep: Puts your computer into sleep mode. You can wake it by hitting a key on the keyboard.

Restart...: Restarts the computer. A confirmation window will pop up before restarting.

Shut Down...: Shuts the computer down. A confirmation window will pop up before shutting down.

Log Out...: Logs you out of your account. A confirmation window will pop up before logging you out.

The Finder Menu

The Finder menu is a new addition to the menu bar. It allows you to make quick changes to the way Finder looks and functions, as well as performing minor actions in the Finder interface.

About Finder: Tells you what version of OS X Finder you are using.

Preferences: Brings up a window which offers many user preferences relating to how the Finder interface looks and functions. The preferences feature will be found in this same menu for each application. For example, if you are in Microsoft Word, this menu will say Word instead of Finder, and preferences for Word will be found here.
**Empty Trash:** A feature that was stored in the **Special** menu in OS 9. This command empties the Trash. This can also be accomplished by Ctrl-clicking on the Trash icon in the Dock and selecting "Empty Trash."

**Services:** Allows you to perform basic system commands quickly, such as making a new sticky note. With questions regarding the items in this menu, contact Computer Support at x.3832.

**Hide Finder:** Hides the Finder application. This feature is also present when an application is open. For instance, in Microsoft Word, you would see **Hide Word.**

**Hide Others:** Hides every open application other than Finder. Click on an application's icon in the Dock to show it again.

**Show All:** Reopens all hidden applications.

---

### The Go Menu

The Go menu contains shortcuts to the standard OS X folders, quick access to all of the items in your Favorites folder, and shortcuts to folders and drives you have recently accessed.

---

**Go to Folder...:** Brings up a window containing a field. If you know the name of a folder you would like to open, you can type it here and it will open. This can save the time of browsing to a folder.

**Connect to Server:** Brings up a window similar to the one shown below. The same can be achieved by typing Command-K on the keyboard.
The main window allows you to browse the network, as you would in the Chooser. This will only work if you have made Appletalk active in the System Preferences (see the System Preferences section of this tutorial for more information regarding Network settings).

The Address field allows you to connect to another computer or server using an IP address.

File, Edit, View, and Window Menus
These menus are basically self-explanatory, serving the same purposes as in OS 9. Although, one useful menu item worth mentioning here is **Show View Options** in the **View** menu. This option is available when you are in the Finder interface. Clicking this menu item will bring up a window containing the settings necessary to alter how your desktop looks, including icon and text sizes.
Spotlight

Your Mac may be the center of your world, holding vast amounts of applications, and files ranging from the last family get-together, to school homework, to important work presentations. Use Spotlight when you need to find something fast and easy.

Not only will Spotlight start finding files the moment you start typing in the Spotlight search field, it'll display files, folders, and applications whose names match your search criteria, as well as files that contain your criteria within them, such as in text documents, applications, emails, calendars, and more. For example, if you type "sandra", Spotlight will locate emails that have this name, as well as documents that contain the text "sandra" in them.

You can access Spotlight from its menu bar icon or in any Finder window

Spotlight is available system-wide. To access it, click the Spotlight icon in the upper-right corner of your screen (or press Command-Space Bar) and type what you're looking for in the resulting field, or type your search criteria in the search field in any Finder, System Preferences, or application window that supports it. For example, you can type ".jpg" if you want to find all JPEG images on your Mac, or type a friend's email address and a couple keywords to locate a particular email from your friend about the subject matter you specified.

The moment you start typing, Spotlight begins to show you what it has found, organizing your results by category (including Applications, Documents, Images, and PDF Documents). The more you type, the more refined your results will be. Tip: You can use the Spotlight pane of System Preferences to arrange the order of these categories and specify categories which will appear.
If there are a lot of results, Spotlight won’t display everything in the menu or window. If you want to see everything, click Show All to open a Finder window that shows all results.

From within the Finder window, you can click one of the buttons below the window toolbar to tell Spotlight where and what to search. For example, click This Mac to search everywhere on your Mac, or click your user account name to have Spotlight search everything in your home folder.

Also, you can click Contents for your search to include the contents of the files, or click File Name to have your search apply only to the File Name of your files.

To open an item in the results list, just select it if you’re viewing the Spotlight menu, or double-click the item if you’re looking at results in the Finder.
Navigating OS X

When you wanted to find something in OS 9, you would double-click your Macintosh HD icon. From there, you would proceed to open folders until you found the file or application you wanted.

In OS X, this process works the same way it did in OS 9. As a matter of fact, there is a quicker method of opening Finder's browser window than double-clicking the hard drive icon. All you have to do is click once on the Finder icon in the Dock. This will bring up a window that looks like this:

You will notice the mouse pointer on the image above. Clicking on this button always switches the window to Icon View. Clicking on the second button will switch it to List View, as seen below:

Both Icon View and List View were present in OS 9. OS X no longer offers button view. Yet, OS X has one new useful view to offer, called Column View, which is set by clicking the third button, as seen below:
In Column View, clicking on a hard drive icon or folder will expand the contents of that folder into a second column, and selecting a folder in the second column will expand its contents into a third column and so on. This mode essentially creates a "folder tree," rather than opening each folder in a new window.

You will also notice that in OS X, by default, each folder opens in the same window. If you would like each folder to open in a new window, you can select this option by opening the Finder menu and clicking Preferences. Check the box next to Always open folders in a new window.

OS X places a shortcut to System Preferences in the Dock. Clicking the Dock icon once will open the application.

OS X 10.4 screenshot above)
Categories

As you can see above, the System Preferences window is divided into five categories:

- Personal
- Hardware
- Internet & Network
- System
- Other (This is after OS X 10.5)

The **Personal** category contains the items (called **pref panes**) which control each user's personal account settings. These settings determine the look and behavior of Mac OS X when you are logged into your account.

The **Hardware** category contains the pref panes you can use to set your personal preferences for the performance of your system's hardware.

The **Internet & Network** category contains the pref panes used to set up internet and network settings. File sharing preferences are also stored here.

The **System** category contains the pref panes necessary to control settings which affect your computer at a more technical level.

Shortcuts on the Desktop

To place additional shortcuts or icons on the Desktop, go to the Finder Menu > Preferences > General > Show These Items On The Desktop.

Place check marks in the items that you want to have appear on the Desktop.
How to Copy and Paste with a Mac

As crazy as it sounds, if you are just learning to use a Mac, this is one of the first questions or problems you will likely encounter.

On a Mac computer, the Command key is generally located adjacent to the spacebar and is often labeled with a ⌘ symbol that resembles a four leaf clover. The following key combinations require that you first press and hold the Command key, while proceeding to press the letter assigned to the Copy, Cut or Past function.

To Copy with a Mac, use the following key combination:

Command + C

To Cut with a Mac, use the following key combination:

Command + X

To Paste with a Mac, use the following key combination:

Command + V
Installing Applications

Installing applications on Mac OS X is incredibly easy compared to most platforms. However, the approach taken can be confusing at first for many users.

There are generally three basic steps when installing a piece of software; Acquire, Un-package, Install.

Acquisition

First the software must be acquired. It could be downloaded from a Web site or stored on a CD/DVD. Downloads are saved by default to the Downloads folder.

Un-package

Before any software can be installed, it must first be un-packaged. If you are installing from a CD or some other kind of disk then you can generally just insert the disk into your machine and skip this step.

In order to make a downloaded program smaller, software publishers often compress their programs by packaging them in all manner of ways. Some of these are described below.

ZIP files

Zip files are handled natively by OS X and should appear as in the picture below. To un-package a zip file, simply double-click it and wait for OS X to open it.

Stuffit files

Often, programs are compressed with Stuffit. These files have a .sit or .sitx extension. Un-packaging these files requires Stuffit Expander or The Unarchiver, which you will need to download if you are running Mac OS X 10.4 or later, otherwise it should already be installed in your applications folder. You can download it for free from the Stuffit site. A typical Stuffit file is shown below.
Disk images

Disk images are probably the most commonly used method for packaging a program. A disk image can be thought of as the virtual equivalent of a CD. The actual data in the disk image is contained within a single file which will look something like this:

![pause2.0.3.dmg]

You then "insert," or "mount," the disk image into the machine by double-clicking the file. Having done this, the disk image will appear as another device in the Finder, as shown in the picture below:

![Disk image mounted in Finder]

Some disk images are `web-ready`, i.e. when downloaded by Safari, they are automatically mounted, and their contents are copied to the download folder (usually the user's Desktop). Then they are unmounted and moved to Trash. The end result is that you have the application on your Desktop, and nothing else. Cool.

Installation

The final step of the process is to actually install the software where you want it.

Software publishers will provide the installation of their software by one of two methods. They will either give you the application bundle to install, or provide an installer. Both offer very easy installation.

Application Bundles
Application bundles are generally used for smaller pieces of software, such as simple applications downloaded from the Internet. Here, the software publisher has provided you with the actual program — all you have to do is copy the program to your desired location (usually your Applications folder) and run it. Copying the program is performed simply by using drag and drop. An example of this is shown below:

You click on the Evernote icon and hold and drag over to the Applications icon. When a Green + (plus) icon appears, release the click and the application is installed.
Burning CDs

Burning CDs or DVDs within the Mac OS X Finder is extremely easy and very similar to working with any other storage device.

To write your own CD/DVD, first insert media into the drive. The Mac OS X Finder will prompt you to prepare the CD, as seen in the image below. Again, this doesn't actually write anything to the CD just yet, but it tells the computer what your intentions are for the disk.

![Preparation Prompt](image)

Enter a name for the CD/DVD you are writing—it will appear with this name on the Desktop. Next, choose a format. There are three formats provided:

- **Standard**— An HFS+/ISO 9660 disk for storing Macintosh data and files.
- **MP3 CD**— A strict ISO 9660 volume, useful for cross-platform data and writing MP3s.
- **iTunes Audio**— A standard music CD to be used with consumer CD players.

Finally, click Prepare to start using the CD on your system. If you'd like to leave the CD in the drive but not prepare it (for use in another application, such as Roxio's Toast), click Ignore.

After a few seconds, an icon representing the CD will appear on your desktop. You can interact with this virtual volume as you would any other under Mac OS X. Copy files to it, delete files, and so on.

When you've created the CD layout that you like, you can start the burn process by choosing Burn Disc from the File menu, or by clicking the Burn toolbar shortcut. In addition, dragging the CD to the trash will also prompt for burning to begin. Mac OS X will display the dialog shown below.

![Burn Confirmation](image)
To choose Burn Disc from the File menu, the frontmost Finder window must be the CD/DVD's window. If the CD/DVD is not the active window, the menu item will be disabled.

Click the Burn button to start the process of writing the CD/DVD. This will take a few minutes, and will be tracked by the Finder must like a normal copy operation. If you've decided against writing the CD/DVD, click Eject to remove the media and erase the CD/DVD layout you've created.

**Burning ISO’s**

The delightfully useful Disk Utility built into OS X can burn disk images to optical media in a few easy steps.

Launch Disk Utility (Applications > Utilities).

Insert your blank DVD or CD.

Drag and drop your .dmg or .iso file to the left pane in Disk Utility. Now both the blank disk and the .iso/.dmg should be listed.

Select the .iso/.dmg file you want to burn to disc, and click on the Burn button. A dialog box confirming the destination (your blank CD/DVD) will appear, as shown:
The disc will now be created and will work on all OS’es.
Taking Screenshots

The following *Mac Screenshot capturing* commands are accomplished by pressing and holding the Command key followed by two or more keys in progression.

- Command + Shift + 3: Takes a screenshot of the entire screen, and saves the image to your desktop.
- Command + Shift + 4, and click an area. Takes a screenshot of an area and saves the image to your desktop.
- Command + Shift + 4, then press space, and click a window: Takes a screenshot of a window and saves the image to your desktop.

To capture a screenshot and save it to the clipboard, use the following keys.

- Command + Control + Shift + 3: Takes a screenshot of the entire screen, and saves it to your clipboard.
- Command + Control + Shift + 4, and click an area: Takes a screenshot of an area and saves it to your clipboard.
- Command + Control + Shift + 4, then press space, and click a window: Takes a screenshot of a window and saves it to your clipboard.

With *OS X 10.5 Leopard*, the following keys can be pressed while selecting an area using Command + Shift + 4 or Command + Control + Shift + 4:

- Space: to lock the size of the selected region and instead move it when the mouse moves
- Shift: to resize only one edge of the selected region
- Option: to resize the selected region with its center as the anchor point
GIVE YOURSELF SOME SPACE

One of the great new features of Mac OS X is Spaces. Spaces lets users customize virtual desktops and allows for switching between them as needed. Spaces helps users keep their applications, files and projects organized so that switching between projects is as simple as clicking your mouse.

Visit your Expose and Spaces pane in the System Preferences configuration tool.

Check "Enable Spaces."

Decide how many spaces you need. Consider adding a space for each of your specific projects or functions. Spaces can be used for work, entertainment, communication or anything else for which you might need to group specific applications. You can customize up to 16 spaces.

Add rows and columns until you have set up as many spaces as you need.

Select keys on your keyboard to control each space with a single stroke.
Assign applications to each space. You may permanently assign programs to one space or to all spaces. Likewise, not all programs require assignment and if left as is, can be accessed from each space.

Group like applications into a specific space. Remember that many major applications are designed to take up the entire display screen; limit how many of these applications go into each space when grouping.

Press F8 on your keyboard or access Expose to display a virtual map of all your designed spaces.

Move from space to space by using your mouse to click on the space that's running the applications that you are interested in using.
EXPOSÉ YOURSELF

When you're heavily involved in your tasks, it's easy to clutter your Desktop with an array of Finder and application windows. Rather than hunt and click through the pile to find the one you're looking for, use Exposé instead.

Exposé allows you to easily navigate through your window clutter by highlighting certain windows, giving you an overview of all open windows (shown above), or clearing everything away.

Exposé is a built-in feature that can give you fast access to any open window with a few keystrokes, temporarily hide all open windows, or scale all windows down so you can get an overview of all of them. Here's how to use Exposé.

- If you currently don't have any windows open, open a few so you can see Exposé in action.

- To show windows by application, press F10; Exposé highlights one application's open window(s) while dimming everything behind it. To toggle through other application windows, press the Tab key. Click a window to select it, or press F10 to return everything back as it was.
To view all your open windows, press F9. To select a window, click it. To return your view back to normal, press F9 again.

To hide all windows so you can see your Desktop, press F11. Press the key again to display the clutter.

Now that you know how to use Exposé, you're probably wondering why would you want to use it? Here are a few reasons.

Need to temporarily clear the clutter? Press F11 and watch all your windows scamper away.
• When you want to drag something from a Finder window into a folder on your Desktop but can't see that folder, start dragging the item, press F11 to hide all windows, and drop the item in the folder.

• If you need to drag a file from one window to another, start dragging the item, press F9 to see all windows, drag the item over the target window until the window becomes active, or press F9 again, and drop in your item.

• When you need to access something on your Desktop, press F11 to hide all windows for an unobstructed view.

• If you need to copy elements between two windows in the same application, start dragging the item you wish to copy, press F10 to display all open windows for that application, drag the item over the target window until it becomes active or press F10 again, and drop it.
Visit the Hot Corner

A "hot corner" lets you activate a feature by moving your pointer into the corner of your screen. You can specify a hot corner for Dashboard in the Dashboard & Exposé pane of System Preferences.

1. Open System Preferences and click Dashboard & Exposé.
2. In the Active Screen Corners section, choose Dashboard from the pop-up menu next to the screen corner you want to use.

You can also set hot corners for Exposé or Screen Saver features in the Dashboard & Exposé preference pane.

From now on, you'll have to be more careful when you move your mouse, but you'll quickly get the hang of it. You'll have instant access to features that will greatly improve your workflow with quick mouse movements.
### Application Switcher

<table>
<thead>
<tr>
<th>Action</th>
<th>Keystroke</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quickly switch between 2 programs (such as: InDesign &amp; Photoshop)</td>
<td>Press Cmd-Tab to switch to the last used program. Press Cmd-Tab again to switch back. NOTE: Press keys quickly and do NOT hold them down.</td>
</tr>
</tbody>
</table>
| Switch between programs (but you choose which program to switch to) | Press Cmd-Tab and continue holding Cmd. While holding Cmd, to choose which program you want to switch to you can:  
  • press Tab (several times if needed) to scroll right  
  • press Shift-Tab or tilde(~) to scroll left  
  • use the left/right arrow keys  
  • aim with the mouse  
  • use end/home keys to just to first/last item |
| Quit a program using the application switcher | When in the app switcher you’re already holding Cmd. Once the program is selected hit Q to quit. |
| Hide a program using the application switcher | When in the app switcher you’re already holding Cmd. Once the program is selected hit H to hide. |
| Cancel out of the application switcher once it’s open | When in the app switcher you're already holding Cmd. Hit Esc or period(.) |

### Working with Windows

<table>
<thead>
<tr>
<th>Action</th>
<th>Keystroke</th>
</tr>
</thead>
</table>
| Switch windows (works in most programs) | Next window: Cmd-tilde(~)  
Previous Window: Cmd-Shift-tilde(~) |
| See where the File/Folder is located (a menu will pop-up displaying the folder hierarchy). This works in “most” programs as well as the Finder. | Cmd-Click on name of the window in its titlebar |
| Move a window in the background without switching to it. (Example: You’re in a dialog and can’t move a window in the background, so Cmd-Drag its titlebar.) | |
Frequently Asked Questions

1. How do I change my desktop background?
2. How do I get an application to open automatically when I turn on my computer?
3. How do I change my login password?
4. How do I set up a screensaver?
5. How do I change my screen resolution?
6. Where do I change my computer's sleep settings?
7. I seem to be having problems using internet, e-mail, or Appletalk devices. How can I check my network settings?
8. How do I set up File Sharing?
9. How do I use my OS 9 applications?
10. Where do I change date and time settings?

Other questions

1. How do I change my desktop background?

In the **Personal** category, click once on the **Desktop** preferences pane. The window will look something like this:

![Desktop preferences pane](image)

You will see a pop-up menu labelled "Collection." This pop-up menu allows you to browse and select a folder of your choice which may contain images. Once you select a folder, the images will be shown below. Click on an image and it will immediately be applied as the desktop background. There is also a check-box at the bottom of the window which gives you the option of having your desktop automatically cycle through all the images in the folder you selected.

2. How do I get an application to open automatically when I turn on my computer?
This is handled by the **Login Items** pref pane. The Login Items window will look similar to the image below:

![Login Items Window](image)

Clicking the **Add** button will allow you to browse your Applications folder. Find the icon for the application you would like to open on startup and click the second **Add** button. Any application you select will now show up in a list. Checking the box next to an item will keep the application hidden until you click it in the Dock.

### 3. How do I change my login password?

To change your login password, first click on the **My Account** pref pane. The window will look like this:

![My Account Window](image)
Next to My Password, click the Change button. This will bring up a new window, where you will be prompted to type in your current password, a new password, and a password hint for the event that you might forget your password at some time. Once you have entered all the appropriate information, click OK to save your new password settings.

4. How do I set up a screensaver?

OS X comes with many great screensavers built in. To select a screensaver, open the Screen Effects pref pane. The window will look like this:

The Screen Effects tab shows a list of available screensavers. Highlight one screensaver from the list to select it. Next, click on the Activation tab. The window will look like this:
You are given a choice as to how long the computer sits idly before the screensaver turns on. You are also given the option of a password prompt on waking the computer. The Hot Corners tab opens the window shown below:

Checking one of the four boxes in this window will make one of the corners of your screen active ("hot"). This means that if you move your mouse all the way into that corner of the screen at any time, your screensaver will be immediately activated. This can make your computer secure while you are away, if you selected to have a password prompt on waking.
5. How do I change my screen resolution?

To change the resolution on your monitor, click the Displays pref pane. The window will look like this:

Click your preferred resolution on the left. Make sure Colors is set to Millions. Unless you are comfortable doing so, do not change the Refresh Rate settings. You will also see a tab labelled Color. Do not make any changes in this tab. Your computer knows what to do by default.

6. Where do I change my computer's sleep settings?

To change sleep settings, click the Energy Saver pref pane. This will bring up the window shown below:
Here you can set sleep settings for your computer, display, and hard drive. Clicking the Options tab will bring up a window that looks like this:

It is recommended that you check the box next to **Wake for network administrator access**. This can help prevent known issues relating to important network activity.

7. I seem to be having problems using internet, e-mail, or Appletalk devices. How can I check my network settings?
Network settings are found by clicking the **Network** pref pane. Once you have opened the window, set **Location:** to **Automatic**, and set **Show:** to **Built-in Ethernet**. The window will look like this:

![Network settings window](image)

**NOTE:** Your window will display numbers for **IP Address**, **Router**, and **Ethernet Address**.

Next, set **Configure:** to **Using DHCP**. Now, look at **IP Address**. If it shows a number beginning with **169** (example: 169.34.45.156), there could be a problem. Next, click on the **AppleTalk** tab. The window will look similar to this:
NOTE: Your window will display your computer name.

Checking the box next to **Make AppleTalk Active** will allow your computer to look for devices on the network using the AppleTalk protocol. If you choose to check this box, make sure **Configure** is set to **Automatically**. The computer will automatically discover your AppleTalk Zone.

8. **How do I set up File Sharing?**

To open File Sharing settings, click on the **Sharing** pref pane. The window will look like this:
NOTE: Your window will display **Computer Name**, **Rendezvous Name**, and **Network Address**.

Under the **Services** tab, there is a list of options. Checking the box next to **Personal File Sharing** will allow you to share files with other Macs. Checking the box next to **Windows File Sharing** will allow you to share files with Windows users.

To turn File Sharing on, click the **Start** button. To turn it off again, click the same button, which will now say **Stop**.

9. **How do I use my OS 9 applications?**

Most OS 9 applications can still be used in OS X, using a program called **Classic**. Classic is essentially an interface which simulates OS 9 within OS X, allowing you to run your old applications. Settings for Classic are found by clicking the **Classic** pref pane. The window will look similar to the image below:
In this window you can click buttons to Start, Stop, Restart, or Force Quit Classic mode. If you would like Classic mode to open when you start your computer, check the box next to Start Classic when you log in.

10. Where do I change date and time settings?

Date and time settings are changed in the Date & Time pref pane. This pref pane is quite simple so here you will find only a basic explanation of the tabs:

- Date & Time: Set the current date and time.
- Time Zone: Select your time zone.
- Network Time: Advanced users may want to set the date and time using a network server.
- Menu Bar Clock: Chose how time is displayed in the menu bar at the top of your screen.
- In Mac OS 9, printers were set up using the Chooser. In Mac OS X, printer browsing and setup are controlled by a utility called Print Center. Print Center can be located in the following path:
- OS X > Applications > Utilities
• Opening Print Center will bring up a window similar to the image above.

To add a new printer:

1. Click on the Add icon. This will bring up a new window. The pop-up menu at the top of this window contains various options for setting up printers. Just as Chooser could be used to set up AppleTalk printers, so can Print Center. Simply click on the pop-up menu and pull down to AppleTalk, as shown in the image below.

• 2. Now, all of the AppleTalk printing devices in your zone will show up as a list in the center of the window.
• 3. Select a printer and the Add button in the lower-right corner will light up.
• 4. Click the Add button. Print Center will find the printer and make it available to you for printing.

**NOTE:** Unlike the old Mac OS, OS X does not place printer icons on the desktop. They are now stored and managed only in Print Center. If you have questions when using Print
Center, you can click on the Help menu at the top of the screen and click on Print Center Help.

- **TCP/IP Printing**
  - An alternative to printing using the AppleTalk protocol is to print using TCP/IP. One advantage of TCP/IP is that it allows printing over a wireless connection, unlike AppleTalk.
  - Before setting up the computer to print using TCP/IP, you need to obtain the IP address of the printer you intend to use. To find the IP address on an HP 4000 series laser printer, go to the printer and follow these steps.
  - 1. Push the right side of the Menu button once. The display will now read, “Information Menu.”
  - 2. Push the right side of the Item button twice. The display will now read, “Print Configuration.”
  - 3. Push the Select button. The printer will now automatically print out two pages of information about your printer.
  - 4. Look on the second page under the Protocol Information heading. The second item in the TCP/IP section will list an IP Address. It will be a series of four numbers separated by periods (Example: 10.11.110.111). This is the number you will need.
  - To set up the computer to print using TCP/IP:
    - 1. Open Print Center, and click the Add button.
    - 2. Select IP Printing from the pop-up menu, as shown below.

![IP Printing in Print Center](image)

- 3. In the field labeled Printer’s Address, type in the IP address that you found in the previous section, as shown below.
4. Click on the pop-up menu labeled **Printer Model**, and select the printer model, as shown below. (In this case it is an HP 4100)

5. Click the **Add** button. The computer will now be configured to print to the printer using TCP/IP.